Photoshop 5.5

Introduction to Adobe Photoshop 5.5

This is two workshops designed to introduce
you to Adobe Photoshop, a powerful graphics
creation and manipulation tool. You don't need
to be an artistic genius or have previous experi-
ence with Photoshop.

Photoshop 3.5 for Macintosh and Photoshop
5.5 for Windows are almost identical programs.
Keyboard commands are the same except that
Mac uses the command (Apple) key, whereas
Windows uses the Control key, and Windows
calls the Option key Alt.

Copyright Restrictions

Be aware of copyrights! In general, copyrighted
material may be used if:

U It is being used in an academic class, and
nowhere else;

U Only parts of a work, and not the whole
work, are used (i.e., only one picture from a
book);

U The source is always cited, even if the work
is only used in a presentation;

O The item is used spontaneously (as in a
class assignment) and not continuously (as
in courseware: request permission).

Remember that simply modifying a work does
not protect you from infringing on copyright!

What is Photoshop?

[l An image editing program
O An electronic darkroom

U Current version is 5.5. There are currently
no updates needed. Updates (not upgrades)
are available for free from www.adobe.com

U Comes with ImageReady 2.0 for creating

and editing web graphics
Primary Photoshop uges

0 Adjust scanned images for better screen
display or printing

0 Change an image’s file format to:
Move between applications and platforms
Display on the World Wide Web

0 Produce special effects

[l Create original artwork

. Palette defaults:
. 1. To show a specific hidden palette, go

- Minimum system requirements
. PowerMac or Pentium

. As much RAM as possible, 64 MB minimum

. I00+MB free disk space for scratch files

- Photoshop settings

Photoshop's defaults are its original settings

. for window/palette locations, tools, and com-
. mand dialog boxes when the program is first
: installed.

Each time a tool, palette or command

* setting is changed, Photoshop saves the new

- configurations is its Preferences file on the hard
. disk in the Settings folder in the Photoshop

. folder as Adobe Photoshop 5.5 Prefs in Mac

. and Adobe Photoshop 5.5 Prefs.psp in Windows.

= [ édobe® Photoshop® 5.5

- [::‘i ddobe Photoshop 5.5 Settings
Actions Palette
adobe Photoshop 5.5 Prefs
Eulur Settings

* On your computer you can delete the prefer-
- ences file, and allow Photoshop to create a new
- one with its default settings.

. Restore standard settings.
Toolbar defaults:

X . Click the toolbar’s default colors button or

press the letter D. This button restores the
foreground color to black and the background
color to white.

. 2. Click the standard windows button at the

bottom left of the toolbox to display the
document window with title and scroll bars.

=3

to the Window menu and choose the palette
from the list.

. 2. To display all palettes in original positions,

press Command/Ctrl K, click the “Restore
Palette locations to Default” button. This is
not undo-able!

[ Reset Palette Locations to Default ]
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Tool defaults

! 1. To reset all tool attributes, choose Reset All Tools
| from the pop-out menu on any Options palette.

= 2. Click OK or Yes to any dialog boxes.

- z Photoshop Bagics

Massjalai 4 4
Palettes
Navigator: This palette presents a thumbnail view of the image
and a highlighted box that indicated the size of the image
window. Across the bottom of the palette are the image

[ o
marquee Up'[lﬂl'IS \ neEseE

t Tool
Feather: El pixels [+ Anti- allased Reset All Tools

wean |al—m—— |enfm

Navigator Palette magpnification and the zoom buttons and slider.
- o 4 Cptins “h Info: This palette gives you information about the coordinates of
REiind el the cursor and color information for the pixel directly under the
Ap: e |4 M pointer. Also shows the width and height of selections.
4 Kopme oW aem Options: The Options palette changes names depending on

which tool is selected. It allows you to choose the attributes,

_ Info Palete _ appearance, or behavior of most tools.

TRt B Pxinthrush Cptions | ¥ Color/Swatches: These are color selection palettes used to set

[(oerma =) opectty: boo Tv] » colors that will be used by your tools. Colors that you sample
P 0t Ot Gies (click) will change the foreground or background (Option/Alt -

click) color on the toolbox. You can set special color palettes
or add your own custom colors to the Swatches palette.

_ Options Palette _ Brushes: Contains the currently defined
brushes and works with all eight painting |2 E
E R — tools, allowing you to select the shape and - i
o m— ] size of the tool. B Bl el
s ST Actions: It's easy to reproduce frequently SRR AL 3L _
— used multi-step processes and techniques. | # | ® & * =
_ Color/Swatches Palettes _ You use the palette to execute actions and %E
| TR ] Sewiehee ] Brushes | * to create or edit them. _ _
LR B | History: Photoshop 5's answer to multiple Lagiis 4 ™ -r
.lelolol®® Undo. Remembers the last 20 steps by — [[fema & opeeity: fd o] %
2 & B e default to allow you to go back more than |fressres frunsarancy
x | & | & |1 [ one step if you change your mind. L || Layer 1
- Brushes Palette - Layers: Lists the layers for the currently ® ||_| Eachariund .
%ﬂé—‘"*""' LJ active window. Create new layers, delete E
=] L= L Lo layers, move layers within a file, duplicate —L= =
L) . 4 Layers Palette
layers, view a single or selected layer(s), _ _
and set options for each layer in an image. B Chusaals ) 3
|sje]c-lDlR]|E|E Channels: Channels are how Photoshop d |:|'“5' X
-~ Actions Palette -~ remembers the color information of an ® |:|m #t
History " Aot k image, similar to layers. They are also used - l:l oo .
to save selections (alpha channels).
Paths: Paths are vectors like in lllustrator or |- |:|- =
Freehand. A path is a Bezier curve path n“’"’”' il
| [ Bl & [ created with the pen tool. ChaLrII;ILFE?aIILt?eJ iR

History Palette
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Photoshop 5
Contentg of the Toolbox _.n ¥ = ul
Option (Alb-clicking on a tool toggles along hidden subtools. ?l"”'* it

Marquee (M): Rectangular, elliptical, or single column or row selection tool;
includes Crop Tool (C)

Move (V): Moves a selection, layer, or ruler guide
Lasso (L): Freeform, polygon, or magnetic selection tool

([ejojolglwlm
Magic Wand (W): Makes selections by contiguous color range Paths Palette

Airbrush (J): Paints a soft-edged (spray-painted) stroke
Faintbrush (B): Paints a soft-edged stroke

Rubber Stamp (S): Clones (duplicates) an area: picks up an area of color/
pattern and repeats it elsewhere

History Paintbrush (Y): Paints to the last-saved version

Eraser (E): Reverts pixels to the background color or a saved image, or re-
moves pixels on a layer

Pencil/Line (N): Paints with hard-edged stroke; Draws straight lines of varying
width with optional arrowheads

Sharpen/Blur/Smudge (R): Sharpens or Blurs a part of an image; Smudges an
image like a finger dragging through chalk, pastel or wet paint

Dodge/Burn/Sponge (O): Lightens, darkens or increases/decreases color satu-
ration

FPen (P): Seven tools used with the Paths palette to create and manipulate
vector paths

Type/Type Mask (T): Creates text or vertical text or Masks for text-shaped ?:;tgj)zo%sols
selection borders are listed |eft to
Measuring (U): Aids in measuring distances in an image right, top to
bottom.

Qradient (Q): Fills selection or area with various blended colors

Faint Bucket (K): Fills single color area with foreground color

Eyedropper (I: Samples a color from your image

Urabber Hand: Moves viewpoint of image in window, without changing the
image itself

Zoom: Magnify or zoom out from an image; 1/16 to 16 times normal size

Foreground/Background color: Buttons that allow you to change, swap (X), or
revert (D) to default color settings

Standard/Quick Mask Mode (Q): Buttons that turn the quick mask on and off

Screen Mode Buttons: Allow swapping among normal display, full-screen image
with menu bar, or full-screen image without menu bar.

EI!
0

(]
i

Jump-to Button: Clicking this button will open your current image in your
chosen image-editing program, usually ImageReady or lllustrator.

Photoshop 5.5 Navigation Shortcuts and Time-Savers

Photoshop has new keyboard shortcuts that move the file exactly one screen
at a time, which is very helpful when retouching a file at 100% view. Here
are some tips for navigating using an extended keyboard:

[ Press the Home key to go to the upper-left corner of the image.
[ Press the Page Down key to go down one screen.
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O Press Command/Ctrl-Page Down to move
one screen to the right.

O Press Command/CtrlI-Page Up to move one
screen to the left.

U Press the End key to go to the bottom
right-hand corner of the image.

As you may know, there are several ways to
move an object in Photoshop:

I. You can select an area and click and drag.

2. You can press Shift to constrain movement
to a 90-degree axis.

3. You can press Command in Mac or Ctrl in
Windows and press the Up, Down, Left, or
Right Arrow key.

4. You can choose Edit, Transform, Numeric,
and enter X and Y values in the resulting
dialog box.

When you've been altering settings in a
Photoshop dialog box, you can reset the setting
to the settings with which you began without
needing to choose Cancel and exit the dialog
box. Simply press Option (Al to change the
Cancel button into a Reset button. Click the Re-
set button to return the dialog box settings to
their previous values.

There are times you may wish to reapply a func-
tion using the last-used settings (especially the
New File dialog box). To open a dialog box set
to the last-used settings, press Option (Al and
choose the function from the menu.

Using Selection Tools

All selection tools create “marching ants” — en-
closed areas to control subsequent editing steps.
Therefore, all selections must be “closed.” Any
changes made can only apply to pixels within
the selection. Selection tools can be used to-
gether to create your perfect mask. Modifier keys
work similarly with each tool.

[0 The Marquee selects oval, round, square, or
rectangular areas. Holding the Shift key
while selecting constrains you to perfect
squares or circles. The Option (Alt) key
draws the rectangle or ellipse around a
central point.

0 The Lasso tool lets you draw a selection
boundary. When you release the mouse

button, the selection will close with a
straight line from the ending point to the
starting point.

U The Polygon Lasso also creates freeform
selections, but with straight lines between
points you click.

U The Magnetic Lasso is very cool. It creates
a selection following the contours of an
image. Since there are no objects in
Photoshop, it uses contrast and color
differences to determine its path.

[ The tolerance of the Magic Wand can be
changed so that more or fewer adjacent
color areas are selected. The lower the
tolerance, the fewer the color areas selected.
To fill out a selection use Select... Grow. To
select everything noncontiguous in the color
tolerance, use Select... Similar.

U To add to a selection with any selection
tool, hold down the Shift key while making
additional selections.

U To subtract from a selection with any
selection tool, hold down the Command
(Control) key while selecting what you wish
to remove.

O Change a selection to the foreground color
with Edit...Fill or Option Delete (Alt
Backspace). Press Delete (Backspace) to fill
with the background color.

: Using the Type Tool

* The Type (or Text) tool creates text-shaped pix-
- els. Adobe did designers everywhere a great ser-
. vice by upgrading the Type tool in Photoshop 5.
. In previous versions, type was rasterized as soon
. as you hit the OK button. Therefore, if you

* made one mistake you'd have to start over. Now
- your text retains its vector information until you

. are ready to rastorize it (Layer...Type..Render).

. But, until you do, you can not apply any of the

. cool effects for which Photoshop is famous, like

- filters, gradients or color correcting.

0 To create type, click on the type tool and
click in your document. If you do not click
exactly where you would like the type to
appear, don't worry; you can change the
location later. Use the Vertical Type tool to
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The Type Tool Dialog Box
create upright text.

[ When the Type Dialog Box appears.
Choose the font, point size, and other
options you want. Select the alignment:
right, centered, or left. Then type your text
in the box at the bottom exactly as you
want it to appear. The type will be in the
current foreground color unless you click on
the swatch and change it. The type will
appear in the box in the font, style and size
you have chosen. Click OK when done.

Keming: Closing or opening space in between
two characters.

Tracking: Closing or opening space in a group
of characters.

Leading: The amount of space between two
lines of type.

O Your type will appear in your document on
it's own layer. The text can be moved with
the move tool. Notice how the Background
is not affected.

U Note: For complex text images, using
Adobe lllustrator or Macromedia FreeHand
is recommended. Text images may be
easily imported into Photoshop. Use of
these programs is not covered in this class.

You can use ImageReady to edit type set in
Photoshop. However, the ImageReady interface
is slightly different. To edit type in Photoshop,
you double-click the type layer to open the Type
Tool dialog box. However, the same trick doesn't
work in ImageReady. To edit type in Image-
Ready, choose the Type tool and select the text
in the image document window. To modify the
font, size, or local formatting (bold, italic, etc),

Photoshop 5.5

. use the Type palette. To display the Type pal-
* ette, choose Window...Show Type.

Do use Layer effects to create outstanding
type displays.

Do use Photoshop to work with type over 20
points.

Don’t compose large paragraphs in
Photoshop. There are vector and page
layout programs that are much better at
handling large amounts of type.

Don't create type smaller than 20 points in
Photoshop unless the type you are creating
is a part of a collage or artwork. The raster
(bitmap, pixilated nature of Photoshop does
not lend itself well to clean type at small
point sizes.

: Layer Effects
- Some very cool effects can be found in the
. Layer..Effects submenu.:

Drop shadow: A drop shadow usually sits
behind and just off to the side of the object
it is shadowing.

Inner shadow: This effect gives the illusion that
you are looking through a hole in the shape
of a word that is casting a shadow onto
whatever is below.

Outer Glow

Inner Glow

Bezel & Emboss Gives a sculpted look to
your layer

Rulere

0 To show rulers on the top and left sides of
a document window, choose Show Rulers
from the View menu. When the rulers
appear, the units will be the same as those
you last selected in the Info palette. Reset
the units in the Info palette or through the

Units submenu of the

File...Preferences. You
can also access this
dialog box by double-
clicking on either ruler.

7

The cross-hair in the
upper left hand

aliecandra@mac.com
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comer of the rulers is used to set the Zero
Point. The Zero Point can be reset to the
upper left-hand comer by clicking on the
cross-hair.

Using the Layers Palette

Layers are like clear sheets of acetate laid over
your background layer. They allow you to add to
and change your image without losing the paint
underneath.
Create a new layer. Click on the New Layer
icon at the bottom left of the palette.

Delete a layer. Drag the layer to the trash can
at the bottom right of the palette.

Move a layer within a file. Drag the layer name
or thumbnail to the desired location in the
layers palette and drop it.

Duplicate a layer. Drag the thumbnail of the
layer you wish to copy to the New Layer
icon.

Hide a layer. Click on the eye icon in the left
column of its layer.

View a single layer. Option (Alt-click on the
eye icon of the layer you'd like to isolate.
Note that this does not automatically make
the layer active. Option-clicking again will
make all layers visible again.

Link layers. Click on the second column to
link layers so they can be moved together
without merging them.

Opacity refers to how much of the image that
is beneath a given layer is visible through
that layer. 100% opacity means the layer is
totally opaque (solid wherever there are
colored pixels.

Preserve transparency is layer-specific. It masks
out any transparent pixels on a layer, so
only pixels that already have paint can be

e ' altered, and, also,
cannot be removed.
This is similar to how a
selection does not
fi—mesme—%  allow you to paint
TEeT outside the marching
ants, without the bother
of making a selection.

Photoshgp’s representation of Transparency

. Background Layers

. As you work with layers, remember these key
. characteristics of background layers:

[ It cannot include transparent pixels

U The opacity of a background layer cannot
be set lower than 100 percent

U You cannot reposition a background layer in
the Layers palette, it must always be at the
bottom, and no other layer may be moved
beneath it

U You can have only one per image

U You cannot convert a layer into a
background layer

[ Deleting a selection in the background layer
fills the selection with the current
background color

. To create a background layer in an image with-
. out such a layer, choose Layer, New, Back-

* ground. Photoshop will place a background layer
: at the bottom of the layer palette.

. Trangparency

. The gray and white checkerboard you see in lay~
* ers represents transparency. It is like painting on
* a clear sheet of acetate. When you draw on the
- transparency, the pixels on the background and
. other layers are protected. If you select part of

. an image on a layer, the background will not be
. part of the selection.

. Layers and fileg

. Each layer takes up approximately as much
. storage space as the original single-layer file

Use only as many layers as you need,
BUT—

Use as many layers as you need!

- [0 Merging layers combines two or more layers

into a single layer

. O Flattening layers combines all document

layers into a single background layer

. The lower left corner of the document window
. on Mac or the Status Bar on Windows shows
. the current file size:

The left number gives the size of the file if
saved in a single layer (flattened)

The right number gives the file size in RAM

. Only Photoshop native files can have layers!

Page 6
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Creating a New Image

Notice that when Photoshop is launched, it does
not automatically open a blank file for you. You
will see only the palettes and settings that you

left open the last time you quit Photoshop. All of .

the lab machines should open with the default
palettes and settings.

Create a New document. Choose the size you
desire. You can easily make it smaller later,
so overestimate, if necessary. We can also
increase the size later. Choose a name for
your document now if desired, but remember,
this does not save a copy on your disk! You
must use the File... Save or File... Save As...
command to do this.

Your saved image size will increase exponentially

The New File Dialog Box
as you increase the dpi. Therefore the saved
file size on a 150 dpi file is four times that of
a 72 dpi file, not just twice as large.

Saving Photoshop documente

A file format is the manner in which a file is
stored or retrieved

Each time you save a file, that file is saved in a
particular file format that specifies how the data
can be used once saved.

Most graphics applications let you save files in a
variety of formats, Photoshop is no exception.
Proprietary or native formats

[J Optimized for the application program that
created it

0 Typically, only the native application can read
native document files, although several
programs can read Photoshop files, including

Photoshop 5.5
Canvas, MetaTools Painter, Adobe InDesign

and Adobe ImageReady.

* TIP: Keep Photoshop files in native format (.psd)
* as you work on them to preserve layers, etc.

U Files are optimized, so you can work more
quickly

U Layers are lost when you convert to other
formats

U As needed, you can save additional copies
of your files in different formats

- Portable file formats
- [ Can be moved from one application to

another, and often from one computer system
to another

- O These formats can be opened and used by

most graphics, word processing, and desktop
publishing applications.

. [ To see the formats in which you can save a

document, press the arrow to the left of the
Format: box in the Save As... dialog box.

: 0 You will see a list of possible file formats.

Gray formats (Mac only—Windows will only
show possible formats) are unavailable in the
file’s current color mode or as limited by
layers or channels.

Which file format to choose?

. TIFF (Tagged Image File Format)

Specifically designed for the printing of scanned
. images; provide great precision and flexibility

. Can be color-separated

- LZW: Built in lossless compression scheme—no
. pixels are lost when compressed

0 Supported by most professional publishing
software, such as QuarkXPress and Adobe
PageMaker or InDesign

[J Compression can cause problems — avoid
if you have the disk space

. TIFFs are encoded for Mac or Windows
. O Use Mac encoding if you work specifically on

the Mac (it will be faster)

. 0 Use Windows encoding to use file on

Windows or if moving between platforms

: Can include clipping paths that enable images
* to be silhouetted. When an image with a clip~
- ping path is imported into an application that

aliecandra@mac.com
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recognizes clipping paths, the area outside the
path is transparent on screen (usually) and when
the file is printed.

Photoshop EPS (Encapsulated PostScript)

[J Widely used in prepress applications

U EPS images are already translated into
PostScript, so they print more quickly and
with fewer PostScript errors than other
formats on PostScript output devices

(1 Can be color-separated
[0 Can also include clipping paths (like TIFF).

NOTE: on Wintel, the screen preview will not be
transparent, but it will print OK.

O Big files (larger than PSD or TIFF)

PICT
[J Native Mac graphics format
[J Good format for screen presentations, etc.

O Fair printing format — can cause frequent
printing problems with PostScript printers

GIF (Compuserve GIF)

QGraphics Interchange Format developed by
Compuserve — a standard on the WWW

[0 Maximum of 256 colors. Uses indexed color
to keep file size small (lossy)

[J Most appropriate format for images with flat
color areas

0 GIF images can be made transparent and
can be set to load as interlaced graphics

[ Uses indexed color to keep file size small
JPEG

Joint Photographic Experts Group — the
standard for photos on the WWW

0 JPEG compression (lossy) works best on
photographs and continuous color images

[J Compression level is a trade-off between
saved image size and retained quality

0 JPEQ files can be compressed the smallest,
for fastest file transfer, or barely compressed
for preservation of image quality.

Moving files between Mac &
Windows

Photoshop 3, 4, 5 & 5.5 share the same for-
mat and files can be moved back & forth and

. between platforms (some color shifts can occur).
. To open a Mac file in the Windows (or vice-

. versa) version of Photoshop, save that Mac file

* using a file name with no spaces or punctuation,
+ and add .psd to the end of the file name.

- Windows users: Photoshop will always automati-
. cally put the proper extension on the file.

File Format Extension
Native Photoshop PSD
TIFF TIF

EPS EPS
PICT PCT

GIF GIF
JPEG JPG

- Mac users: PS 5.5 will now add the DOS file

. extension to the end of each file you save by

* default—to let you, and the world, know the for-
- mat. You can set it to not add it, or at least ask
. you, in Preferences... Saving Files.

Preferemces
| Senving Files wr 4| @
Image Freviews: | Ahways Save 2] Comcel |
B beom [ Full Sire -
il | Prev |
:I
AR SYE | Meaat ||
Apgend File Extension: |« ASKWhHER S2%i0g
_' LEE LEfsEr CASE
Fiile O g artilility
A Include Compesited Insape 'With Lavered Files

. Color Modesg

(in the Image... Mode submenu)

. 0 Greyscale: mode This is not black & white! A

greyscale image has 256 shades of grey,
from solid black (O) to pure white (255), used
to make up a picture.

[0 RGB mode: Red, Green, & Blue are additive

colors of light displayed on your monitor. The
more saturated (dense) the colors become,
the closer the value gets to white.

. 0 CMYK mode: Cyan, Magenta, Yellow, &

blacK are subtractive pigment inks used in
the four-color printing process; therefore they
are called process colors. Translating an
image from the computer screen (RGB) to
the printed page requires color separation, so
RGB must be converted into CMYK files
before separations can be created for truly
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accurate high-end printing. Low-end printers
(StyleWriters, DeskWriters or DeskJets, or
Epson Stylus) will do an adequate
interpretation of RGB for home printing.

U Bitmapped mode: In contrast to greyscale
mode, bitmapped mode offers only black and
white pixels — no colors and no shades of
gray. These images cannot be scaled,
distorted or treated with filters. To convert a
file to bitmapped mode, it must first be
converted to grayscale.

[ Indexed color mode: Indexed color is a
custom palette of colors that is particular to
an image. QIF files must be converted to an
indexed color mode before saving to reduce
the saved file size.

| id [odar

Palethe: | Peh

Calar Deptic | Biner | |

Calaors: F1é

gl

| Caniel

St

Dptignt
Ditheer: | Mone -

Changing to Indexed Color
U A palette can either refer to a set of tools
in Photoshop or to the set of colors com-
prising an image. When you save a GIF
image for the web you need to use a
palette of no more than 256 colors.

U The palette that you select depends on your
image and on the platform on which you
expect to display your image. If you're not
sure which platform will be used, you may
wish to use a more limited web-safe palette
of 216 colors.

[l The reason to use the more limited palette
is that Windows limits the number of “free”
colors in a browser window to 216 when the
monitor can only display 256 colors. 40
colors are reserved for use by the Windows
system itself to draw the screen. If an image
in a browser window takes more than 216
colors, Windows will substitute “close” colors
for the extra ones. The result is that your
image will not look as you expected if
someone views it in Windows. Note that if
the monitor allows more than 256 colors,
this problem does not occur.

Photoshop 5.5

- Using the Painting Modes

. Photoshop offers different painting modes, found
. on the pop~up menu on the various painting

- tools” Options palettes and on the layers palette.
. These modes affect the way the overlying paint
. interacts with and changes the underlying pixels.

. 0 Normal mode: (1) The blend paint covers the

underlying pixels. This is the most common
mode used.

. O Darken mode: (2) Only pixels lighter than the

blend color are changed.

O Lighten mode: (3) Only pixels darker than the

blend color are changed.

* O Hue mode: (4) The hue of the underlying

pixels changes to that of the blend color, but
the saturation and luminosity (brightness) are
maintained.

. O Saturation mode: (5) The saturation of the

underlying pixels changes to that of the blend
color, but the hue and luminosity are
maintained.

O Color mode: (6) The underlying base pixels

change to the blend color, but the luminosity
is retained. This mode is good for colorizing
grayscale without changing the gray levels.

- O Luminosity mode: (7) The opposite of color

mode. The luminosity of the underlying pixels
changes to that of the blend color, but the
color values are not affected.

. 0 Multiply mode: (8) Uses a mathematical

formula to darken the image.

: O Screen mode: (9) Lightens the base pixels

while giving them a tint of the blend color.
The opposite of the multiply mode.

- U Overlay mode: Either multiplies or screens

depending on the base color. This has the
effect of changing the base color to the blend
color while maintaining highlights and
shadows.

]
1 2 53 4 5 6 7 8 918
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O Dissolve mode: (10) The blend color replaces
the base color at random, based on the
density (opacity or brush hardness) of the
applied paint. The example line is painted at
50% opacity.

U Color dodge and Color burn modes: Using
these modes is like dodging or burning with
the foreground color.

U Soft light and Hard light modes: Soft light is
like a diffused light source while Hard light is
focused. Colors more than 50% gray darken
the base color while colors under 50% gray
lighten it.

U Behind mode: Paints only on the transparent
part of a layer. The effect is of painting under
the base color.

[ Clear mode: Makes pixels in a layer transpar-
ent. Works with the line or paintbucket tool,
or Fill or Stroke.

The History Palette

When Adobe upgraded Photoshop to Version
5.0, graphic artists and designers everywhere re-
Jjoiced. Adobe had added the History palette,
which allows multiple undos. Before 5.0, you
could only reverse your changes back one step.

State: When you make a change to your
image, it is recorded in the History palette.
These are called states. You can make a
snapshot of any state to save for later, or
you can paint with a state using the History
Brush tool. By default, the History palette
will save 20 states.

Snapshot: Snapshots can be used for several
purposes. Let’s say that you like something
you are experimenting with and want to
save it “just in case.” Or, you are running
out of space in the History palette, but you
want to keep a particular version of your
image until you are finished.

Channelg

Channels are similar to layers, in that they con-
tain partial, layered information about an image.
An RGB image always has at least three chan-
nels; a CMYK has four; a greyscale has one
black channel.

. Channels are also used to store and edit selec-
* tions. Select... Save Selection or clicking on the
- Save Selection button on the bottom of the

. Channels palette will create a new alpha channel
. below the color channels in the Channels pal-

. ette. These alpha channels will be saved with

: your PSD files and can be exported in PICT

- and TIFF formats for use in other applications.

- Bitmapped images cannot have alpha channels.

- [0 Channels contain only greyscale (256 shades)

information about your image.

. The Actiong Palette

T you've worked in programs that utilize macros
- (WordPerfect, MS Word or Excel, etc), you may

. be familiar with the concept of scripting complex
. actions into a command you can easily execute
. with just a click or single keyboard command.

. Photoshop's Actions palette allows you to do

* just that. The default settings already have sev-

- eral actions scripted. Actions are made up of

. steps of commands, and each step may have

. sub~steps or settings. In Button Mode (in the

. Actions palette pop-up menu) the steps are hid-
* den, but in List Mode the steps can be ex-

: panded and edited. Button Mode also shows the
- colors and function keys assigned to an action.

- [ The first column of the Action list displays a

check mark to show that Actions or steps are
include and usable. Excluding steps is a
convenient way to temporarily alter Actions
without rewriting them.

. [0 The second column toggles break points on

or off for an entire Action or single step.
Break points within an action pause action to
wait for user intervention. This may be to fill
in options in a dialog box, make a selection,
or supply some other variable. Photoshop will
not let you turn on a break point for a step
with no options. If a break point is not turned
on, the Action will execute without pausing,
using the option values recorded.

. The simplest way to create an Action is to actu-
. ally perform the steps while recording in the Ac-
. tions palette. Photoshop will alter your image as

: you do this, so you might want to work on a

: copy of your file.
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O You can assign Function keys (FI—F15, Shift
FI—F15, Command/Control FI—F15, & Shift
+ Command/Control FI—F15 across the top
of your keyboard (Windows will not use F1 or
F13—F15)) to actions for one-keystroke
implementation of your favorite commands!

Pathe

Paths can be frustrating to learn, but powerful to
use.

The Pen Tool is a Bezier curve drawing device.
There are seven pen tools under the Pen tool in
the ToolBox. You can create lines and shapes
that can be fine-tuned, saved as paths, filled or
stroked, and converted to selections. Anchor
points are joined by segments, which link to
make a subpath. Subpaths combine to form
paths.

U Drawing a straight line: Click in the image
window with the pen tool to create an anchor
point. Click again elsewhere to create a
second point. A line segment will be drawn
between the two.

U Drawing a curved line: Create an anchor
point. Click and hold the mouse button down
elsewhere. A slightly curved line will form
between the two.

[ The arrow tool is used to move anchor
points. The comer tool can be used to
change the anchor points from curves to
corners to straight lines.

Work path: A Work path is a path that has been
drawn with the Pen tool but has not been
saved. This is your work-in-progress. Work
paths must be saved if you want to keep
them; otherwise, beginning a new path will
delete it

[J Save a Work Path from the Paths palette
pop-out menu. You can have many saved
paths that will remain with your psd image.

[J Make a saved path into a clipping path. Both

TIFF and EPS formats will retain your clipping .

path as a transparency mask when you place
it into a DTP program.

The Stroke Path command will use whatever
brush size and tool options have been
selected for the particular painting tool you

Photoshop 5.5

chose.

. Clipping path: A Clipping path is a saved path

to be used in a vector program (such as
Adobe lllustrator, Macromedia FreeHand) or
page layout (QuarkXpress, Adobe InDesign).
A Clipping path removes the image from its
background.

. Think of Clipping path in this way: You want to

cut out a picture of you and your friends to
put in your scrapbook, but you don't like the
background. For a non-digital scrapbook,
you'd have to take scissors and cut, or clip,
away the background before you would be
able to glue it in. This is essentially the same
idea but in a digital format.

. Device pixels are found in the Clipping Path

dialog box (Figure 3-13). The Device pixels
are the units for flatness, which determines
how precise the Clipping path will be. You
can enter numbers ranging from 0.2 to 100.
The higher the number, the less precise the
path will be. The lower the number, the better
the precision.

* When printing this image, the path is translated

as a series of flat lines. The smaller the line,
0.2 device pixels, the better the path will be
approximated. You may leave this value blank
and Photoshop will apply the default.

- Saving Your Images for the Web

- You may create all of your simple web graphics,
. like buttons, on one file. This helps guarantee

. consistency in color. Then follow these steps to
: save your files:

* 1. Flatten your image. We need to mash all the

layers together. Choose Flatten Image from
the Layers pop-up menu. Be sure that the
background isn't the active layer or that
option will be grayed out.

. 2. Select one item. Choose an icon, a heading,

or a bar and select it with the marquee. It
doesn’t matter if you use the lasso or the
marquee tool, as long as you completely
select the item you want, and don't select any
part of any other item.

. 3. Copy the item and paste it into a new

document. Choose Copy from the Edit menu.
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Next, select New from the File menu.
Photoshop will suggest a size that exactly fits
the image you just copied, so don't change
the dimensions. Click OK. Paste your image
into the empty space.

. Change the new image to Indexed Color.
From the Image... Mode submenu, choose
Indexed Color. When it asks if you want to
flatten layers, answer OK. In the next dialog
box that appears, select Web palette and
None for dither. Notice that the Web-safe
palette only has 216 colors. This is to make
your GlIFs safe for Windows-based browsers. If
your intended audience has Macs, or Windows
machines with more than 256-color display,

you can choose the Adaptive palette. Click
OK.

5. Save your image in GIF format. Photoshop
only saves rectangles, and automatically
changes any transparency to white in all
formats except Photoshop. If you do not need
transparency, go ahead and choose Save As...
and select Compuserve QIF in the Format

pop-up menu. If you want to preserve
transparency, you must use File... Export...
GIF89a Export.... You will get a dialog box
that will allow you to choose colors (e.g.,
white) that you wish to be omitted in the
saved image. Name your image
something.GIF and click Save. Now you can
display it on the web!

. Repeat steps 1-5 for each of the images you

wish to save for the web.
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